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Preface

Easy Time Control Software is an all inclusive Time and Attendance business solution
that interfaces with the existing payroll systems and allows organizations and
individuals to electronically collect and track real time workforce data, thus helping
to streamline the payroll process.

This training manual helps you to use the features of Easy Time Control, reducing
the processing time and decreasing the errors associated with a manual time-

keeping process

Conventions Used

The following conventions are used in this manual.

Bold face Menu items, button names, field names

Italics Emphasis







Module 1
Getting Started



1.1. Opening the System

To open Easy Time Control follow either of the steps:

® Double-click the icon on the Desktop or Quick Launch or follow the path Start >
Programs > Easy Trinity > Easy Time Control > Easy Time Control. The
Getting Started screen opens. If you do not want this screen to be opened every
time you log in, select the option Don’t show this form again. If users have
been added to the system and were assigned a role, either Supervisor or Simple
user, and a username and password, they will have to log into the system

providing the User Name and Password.

Easy Time Control - Getting Started

A

Getting Started

Flease make your selection:
If you are a novice user you might use our Setup Wizard which will walk you
through the whole setup process.

1 You can also use a sample Company information in order to test all program
features.
Orr you can skip these steps and open the main form of the program right away.

M

What would you like to do?

(*) Use Setup Wizard
() Open Sample Company
() Open Easy Time Control Main Form

[ ] Don't show this form again

Getting Started screen
There are three options:

1. Use Setup Wizard - If you are using Easy Time Control for the first time,

select this option. This option will take you through the setup process.

2. Open Sample Company - This option provides the details of a sample

company for you to test the features.

3. Open Easy Time Control Main Form - This option opens the main form.



e While opening the application again and you don’t want the Getting Started

screen to be displayed, select the option Don’t show this form again.

e Click OK.

1.2. Using Setup Wizard

The Setup Wizard helps you manage your company’s information.

1.2.1. Company Wizard
The first step is to register the company. Follow these steps:
1. Ensure that the option Company Wizard is selected and click Next.
Wizards E
Add New Company D vescriptionllll
This Wizard will help you
manage your Comparty

(3) Company Wizard

() Settings Wizard

irformation. The first thing
you need to do is to register
your Compariy.

Easy Time Control Express
Edition only supports one
Company. Easy Time
Control Professional Edition
supports more than one
Compary so you will be
able to add and manage

information for muttiple

Companies.

Close Wizard

Company Wizard

Note: Based on your edition of Easy Time Control Software, you will be able to add

companies. For instance, Free and Express Editions support only one company;

whereas, the Professional and Enterprise Editions can support multiple companies.

2. Click Next. The Companies Wizard page displays the list of companies.




Wizards

Add New Company

C y D | C

y Name | Abbreviation

| Address

<

|

X

Description |
You can enter your

Company infarmation when
you click “Next™ button.

Company D is a numeric
value that you need to
assign to the Company and
it has to be unique.

You will be able to create
- and assign Departments
" and Employees to the

Company after you

complete this task.

cBack | [ Nex>

3.

Wizards

List of companies
Click Next to add a new company.

Add New Company

=Company ID0: |1

= Company Name:

|ABC Incorperated

Abbreviation: |F\BC Ine
Address1: 35, Walter Avenue
Address2: |

City: |New York
State/Province |

Postal/Zip Code: |

Country: | uss

De=cription: |

Description |
You can enter your

Compary information when
you click "Next™ button.

Company ID is a numeric
value that you need to
assign to the Comparny and
it has to be unigue.

"You will be able to create
~and assign Departments
~and Employees to the

Company after you

complete this task.

’ < Back ] [ Mead =

Adding a new company



In this page:
> Provide the Company ID. This should be a numeric value and be unique. A
value will be displayed, which can be changed. This is a mandatory field.

> Enter the Company Name. This is also mandatory.
Note: The Next button will be enabled, only when the mandatory fields,

denoted by asterisk (*) are filled in.
> Mention an Abbreviation.
> Specify the address details.
> Provide a Description.
> Click Next.

You have now registered a company. You can select the option Company Wizard
again and continue registering another company, or select the other available options.

1.2.2. Department Wizard

Click Department Wizard to create the departments to group the employees. The

number of Departments is unlimited regardless of the Edition. Click Next.

Wizards E|

Add New Department _ Deﬁcriptioii-

This Wizard will help you
= manage your Department

© Compary Wizard infarmation. Mow that you
have your Company setup,

(=) Department Wizard you c;n c:reatep i E
Departments to group your

O Employee Wizard employees.

(O Shift Wizard Easy Time Control Exprass

Edition does not support
Depatments. Easy Time
Control Professional Edition
() Exception Wizard supports more than one
* Department so you will be
~ahle to add and manage
irformation for muttiple
() Settings Wizard Departments.

e

Departments Wizard
The registered companies are displayed in the dropdown list. Choose the Company to

which you want to add the departments. Click Next.



Wizards

Add New Department TN oescriptionlill

You can enter your
Department information
when you click "Mext™
button.

Company: ABC Incorporated "|

Department | You will need to select an

existing Company to which
you will assign your new
Department.

(o] o

List of Departments
In the Add New Department screen, enter the Department name. This is a mandatory

field. Click Next.

Wizards

Add New Department TN oescriptioniill

You can enter your
| Department irformation
when you click "Mest™
button.

= Department: ||rrforrnation Technology|

"You will need to select an
existing Company to which
you will assign your new
Department.

| L

)

Adding a department
You have now added a department. You can add additional departments, or select the

other available options.



1.2.3. Employee Wizard

Click Employee Wizard to enter the information of the employees. You can add as
many employees as the number of employee licenses you have. The number of active
employees that can be maintained at the same time depends on edition you have
purchased. Free Edition is limited to 10 employees; the other editions can have
unlimited number of employees. Click Next.

Wizards El
Add New Employee D Descriptioilill
This Wizard will help you
O Company Wizard s, Varetoe
(O Departmert Wizard Elérbrllzltoif::searsa;ranr?yrﬁser
) B Wisrd licenses you have.
(O Shift Wizard

() Exception Wizard

() Settings Wizard

e

Employees Wizard
From the dropdown list, choose the Company to which you want to add the

employees. Click Next.



X

Add New Employee NN oescriptioniill

You can enter your
Employee information when
you click "Next™ button.

Wizards

Company: |ABC Incomorated & |

| Last N You will be able to assign
your new Employee to an
existing Department.

Employee ID | Department | First Name

< Back l L Next = J Close Wizard

List of employees

The Add New Employee page opens.

Wizards |z|

Add New Employee NN vescriptioniill

You can enter your

- Department: ) Employee information when
| Mot Defined e | you click "Mext™ button.

= Employee ID: | il You will be able to assign

your new Employee to an

* First Name: | John : axisting Depatment.
Lastame  ooe |

Role: | Not Defined v|

Login: | |

Password: | |

Active:
- Required fields

coos ) e ]

Adding new employees



In this page:

>

>

>

>

Choose a Department.

Enter the Employee ID. This should be a numeric value and be unique. A

value will be displayed, which can be changed.

Mention the First Name and Last Name.
Note: The Next button will be enabled, only when the mandatory fields,

denoted by asterisk (*) are filled in.

Choose the Role of the employee. You can assign two different roles to the
employees: Supervisor and Simple User. If you want to use different roles,
you should assign the role of supervisor at least to one employee initially.
You can also omit assigning roles. If you assign one or more users as
Supervisors, then the Login screen appears when you re-launch the

application.
Provide a User Name and Password. You can assign user name and

password to both supervisors and simple users; however, the difference is

explained in Section 3.1.2. Time Clock.

Specify whether the employee is Active.

Click Next.

You have now added an employee to the department.



1.2.4. Shift Wizard

After adding employees, you can create shifts. Select Shift Wizard and click Next.

Note: Using the Free or Express Edition of Easy Time Control you will not be able to

create shifts. Only the Professional and Enterprise Editions support the option of

creating shifts.

Wizards

Add New Shift

() Company Wizard
() Department Vizard
() Employee Wizard
() Shift Wizard

() Exception Wizard

() Settings Wizard

3

Description
Once you have entered
your Employees
irformation, you can create
different Shifts. This VWizard
will help you manage your
Shifts information.

Easy Time Control Express
Edition does not support
Shifts. Easy Time Cantrol
Professional Edition

» supports more than one

Shift so you will be able to
add and manage
irformation for muttiple
Shifts.

s
[¥1]
g
v

Shift Wizard



From the dropdown list, choose the Company and click Next.

Wizards

X
Add New Shift BN oescriptionlill

You can enter your Shift

irformation when you click
“Mext” button.

Company: | ABC Incorporated b |

Shift Date From Time From T You wiIIl be able to input
your Shift parameters.

(I—

s ) [

List of shifts

In the Add New Shift page, set the shift parameters:

>

>

Provide the Shift Name.

Specify the date from which the shift is applicable. By default, the current
date will be displayed, which can be changed.

Choose the shift timings.
Select the Color for the shift indication.
Set the Punches Rounding Rules.

The shifts should be divided into intervals for the purpose of rounding. Set
the interval by selecting the number of minutes in the Shift partitions in

dropdown list.

o Choose the options for rounding the Punch INs and Punch OUTs.
For instance, consider that the shift interval is set to 10 minutes and the

Punch IN and Punch OUT round options are set to 5 minutes each.

Scenario 1

Consider that for a shift beginning at 7:00 AM, an employee punches IN
at 7:03 AM. Here the Actual Punch IN will be 7:03 AM and the Rounded
Punch IN will be 7:00 AM.




Scenario 2

Now if another employee punches IN at 7:07 AM for the same shift, the
Actual Punch IN will be 7:07 AM, whereas the Rounded Punch IN will be
7:10 AM, which is the end of the interval.

Choose the options for indicating the grace period for the Punch IN and
Punch OUT timings. These options are used to allow an employee to
punch before the beginning of the shift or after the end of the shift, and
still be considered as punched within the shift timings. The grace time
will be considered as overtime. If the grace period values are set to 0
minutes, it indicates that every punch IN before the beginning of the
shift and the grace period will not be included in the shift timings. This
also applies to any punch OUT that occurs after the end of the shift.

For instance consider that the grace Punch IN time is set to 30 minutes.
Scenario 1

If an employee punches IN at 6:32 AM for a shift beginning at 7:00 AM,
the Actual IN time will be 6:32 AM and the Rounded IN time will be 6:30
AM. The grace time will be considered for overtime.

Scenario 2

If an employee punches in at 6:26 AM for a shift beginning at 7:00 AM,
the punch will not be considered as recorded within the shift and the
grace time will not be considered for overtime. In addition, the icon @
will be displayed in the Status column indicating a problem with the

punch IN.

For instance consider that the grace Punch OUT time is set to 30
minutes.

Scenario 1

If an employee punches in at 3:23 PM for a shift ending at 3:00 PM, the
Actual OUT time will be 3:23 PM and the Rounded IN time will be 3:20
PM. The grace time will be considered for overtime.

Scenario 2

If an employee punches out at 3:31 PM for a shift ending at 3:00 PM,
the grace time will not be considered for overtime. In addition, the icon
o will be displayed in the Status column indicating a problem with the
Punch OUT.



> Mention the Break/Lunch Time that has to be deducted from the shift

time.

»  Click

Next.

Add New Shift

= Shift Mame: Earty Moming Apply From:

Time From:  |0700AM % Time Ta:
cowr

—Punches Rounding Rules

Shift partitions in: I'IE 5: minutes intervals.

Punch IN roeunds to beginning =————minutes passed from beginning of interval.

Punch OUT rounds to beginning z———minutes passed from beginring of interval.
time of an interval if less than:

Punch IN will be registered within - ———— .
the shift i it will take place less than®) —| minutes before the shifis starts.

Punch OUT will be registered withinf35~ =

the shift if it will take place less than. B

time of an interval if less than: I —10thenwise it will round ta end of the interval.

=1 Jtherwise it will round to end of the interval.

Break/Lunch Time: minutes to be deducted from shift time.

You can enter your Shift
irformation when you click
“Mext™ button.

You will be able to input
your Shift parameters.

[ < Back ] [ = .]

Setting the shift

You have created a shift. You can select the Shift Wizard and create more shifts.



1.2.5. Shift Assignment Wizard

After creating the shifts, click the option Shift Assignment Wizard, and click Next.

Wizards

Add New Shift Assignment 000 Description |

This Wizard will help you
assign existing Shifts to
your Employees.

() Company Wizard

() Department Vizard

) Flease click Next button to
(O Employee Wizard atart.

() Shift Wizard

(2) Shift Assignment Wizard
() Exception Wizard
() Exception Assignment Wizard

() Settings Wizard

Shift Assignment Wizard




In the Add New Shift Assignment page, choose the Company. Select an employee
from the list of Employees. Click Next to assign shifts to the selected employee.

XY - Departments Wizard

Add New Shift Assignment

X]

DN Descripticallill

Company: | XZ

v

I Employes IDE First Name | Last Name

|

| Department | Select
Mot Defined

First you need to select 3
Company from drop down
box at the top of this
window.

Then you need to select an
Employee from the list of
your Employees.

| Press Mext button to go to

[the next step where you

" can assign Shifts to the
Employee.

’ < Back ] ’_ MNexd

Close Wizard

Choosing Employees

In the next screen, select one of the available shifts. Select the Days the shift has to

be assigned to the selected employee. Note that you will not be able to assign more

than one shift to a person on the same day.




Note that only when the Days are selected, the Next button will be enabled. Click
Next.

Add New Shift Assignment ]

4 March 2008 April 2008
S M T WTF s S M T WTF §
24 25 26 27 28 9 1 IR S
Z 3 4 5 5 & 8 s [F 8 9 1 1112
5 10 11 [EEEISERE 15 1314 15 16 17 18 13
15 (47718 18 20 21 22 021 22 23 23 25 6
23 (24735 96 27 28 29 27 |22 NE0 FON T -
30 |51 56 7 5 5

IN/OUT

Shift | MDn| Tue| Wecl| Thu| Fri| Sat| Sun|AulD Punc_hes|Elﬂ
Marning | BN |

Description |
Select a Shift from the list
below and using calendar
control select days to
which you want to assign
the Shift. You can also use
week day's check boxes
below in order to assign the
shift to multiple days
comesponding to a week
day that you select. These

|days will be highlighted with
'\ comesponding color.

MNote that you will not be
able to assign more than
one Shift to a person on
the same day. Using this
'Wizard you can also
manage Auto Punches
feature.

Click Mext button to save
the changes you have
made.

Adding New Assignment

Assign shifts to all employees by selecting the Shift Assignment Wizard again.




1.2.6. Exception Wizard

There might be instances where you want to specify some exceptions. For such

exceptions, click Exception Wizard. Exception Rules indicate when the employees

should be paid for a set number of hours even though it was their day off, holiday, or

they did not work the full shift on those days. You can create many exception rules,

using different color indication. The program will automatically recalculate the working

hours considering the rules applied. You can apply the rules using Exception

Assignment functionality.

Wizards

Add New Exception

) Company Wizard
() Department Wizard
() Employee Wizard

) Shift Wizard

() Shift Assignment Wizard

3

Descri ptioi.
This Wizard will help you

manage your Exceptions
information.

Easy Time Control Express
Edition does not support
Exceptions. Easy Time
Control Professional Edition
supports more than one
Exception so you will be
able to add and manage

information for multiple
(®) Exception Wizard | Exceptions.
() Exception Assignment Wizard
() Settings Wizand
e

Exception Wizard

Note: Using the Free or Express Edition of Easy Time Control you will not be able to

create exceptions. Only the Professional and Enterprise Editions support the option of

creating exceptions. In the Exceptions page, choose the Company. Click Next.




Wizards |§|

Add New Exception T oescriptionllll

You can enter your
Exceptions information
when you click "MNext™
button.

Company: |ABC Incorporated b |

Exception | Deseription | Daily paid hours | Color |

You will be able to input
your Exception parameters.

—

(oo ) (e ]

Choosing company
In the Add New Exception page:
> Enter the Exception Name, which is mandatory.
> Provide a Description.

> Choose the Daily Paid Hours and the Color and click Next.

Wizards |z|

Add New Exception T oescriptionllll

You can enter your
| Exceptions information
when you click "MNext™
button.

- Exception Name: |Holic|a’1.r

Description: | |

You will be able to input

Daily Paid Hours: m Color: your Bxception parameters.

= Required fields

o ] e

Adding New Exception



Now you have registered your company, created departments, added employees,

defined shifts, assigned shifts to employees, and created exceptions.
1.2.7. Exceptions Assignment Wizard

After creating the exceptions you can assign the exceptions to the employees. click the

option Exception Assignment Wizard, and click Next.

Wizards E|

Add New Exception Assignment — Dﬁcripﬁm

Thig Wizard will help you

(O Company Wizard 2ssign your custom
: Exception Rules that you
(O Departmert Wizard created earier to your
Employees.
() Employee Wizard

Please click Next buttor to
() Shift Wizard start,

() Shift Assignment Wizard
() Exception Wizard
(#) Exception Assignment Wizard

() Settings Wizand

=

Exception Assignment Wizard
In the Add New Exception Assignment page, choose the Company. Select an
employee from the list of Employees. Click Next to assign exceptions to the selected

employee.



Wizards

Company: |ABC Incomporatad

v

S

Employes ID! First Name | Last Name | Department | Select
) Mot Defined

X]

Descripton 1

First you need to select 3
Company from drop down
box at the top of this
window.

Then you need to select an
Employee from the list of
your Employees.

| Press Mext button to go to
the next step where you

’ < Back ] l MNexd J

Choosing Employees

In the next screen, select one of the available exceptions. Select the Days, from the

calendar, the exception has to be assigned to the selected employee.




Note that only when the Days are selected, the Next button will be enabled. Click
Next.

Wizards

Add New Exception Assignmer

&

4 March 2003 April 2008
5 M T W T F 5 5 M 7w T S
2425 X% 27 282 1 il & 4. 5
3 = b B B 7 8 9 A0 11 13
E 11 13 14 15 13 14 15 16 1F 18 19
16 17 18 19 20 21 23 20 21 22 23 24 25 2%
23 24 25 26 27 28 29 27 28 29 30 1 2 3
3031 4 5 3 7 3 g 1
—Exceptions
Exception | Color

Description |

Select an Exception Rule
fram the list below and
using calendar control
select days to which you
want to assign the
Exception. These days wil
be highlighted with
comesponding color.

- Mote that you will not be

able to assign more than
one shift to a person on the
same day.

Click Mext button to save

m

&

1.2.8. Settings Wizard

Adding New Assignment

The Settings Wizard helps you manage your program general settings. Click Settings
Wizard and click Next.




Wizards

Settings

() Company Wizard

() Department Wizard

) Employes Wizard

() Shift Wizard

() Shift Assignment Wizard
() Exception Wizand

() Exception Assignmert Wizard

(@) Settings Wizard

X]

Description |
This Wizard will help you

Manage your program
Settings.

Settings Wizard




Date and Time
This page allows you to set the time and week format.
» Time Format — Sets the time format. There are two options available:
= Civilian Time - Displays the time in the AM/PM standard format
= Military Time — Displays the time in the 24 hour military form.

»  First Day of Week — Allows you to define the day of the week that would be
the starting day for payroll calculations.

Settings Wizard

Date and Time Descriptions |
This Wizard will help you
Time Format - Manage yaur program
Settings.
(® Civilian Time (AMPI} O Wilitary Time Please sslect Civilian
; Time' in order to have
First Day of \Week AM/PM time standard.
Plzase select "Military Time'
e L 2 \in orderto have 24-hour
3 [ [|time standard. | |
.-i (%) Monday ) Friday | i [ ]

'ou can decide what week
) Tuesday () Saturday ay will be a starting day for §
your payroll period. ;

() Wednesday () Sunday

[ < Back ] [ Neat > Close Wizard

Date and Time setup
After choosing the relevant options, click Next.



Accounting Period
This page allows you to define the accounting period for payroll calculations:

> User Defined - Allows you to customize the period. Select the option and

specify the From and To dates.
> Weekly - Considers weekly accounting period.

> Bi-Weekly — Considers bi-weekly accounting period. Select the option and

specify the starting date.

> Monthly - Considers monthly accounting period.

Settings Wizard

Descriptions |
; : Thig Wizard will help you
Accounting Period Type MENage your program
Settings.

Accounting Period

Q U=er Defined
‘User Defined’ in order to
F P — T P select what dates will be
Ly | — | o | ——— starting and ending dates
for your payrall period.

(&) Weskly
“Weekly' =0 your weekly
2 | payroll period will start from |
O siweeky J weekday of your selection. |
Peried Start: 1/7/2008 Or 12/31/2007 'Bi-Weekly' so you can set
starting date to the cument
) Monthly or previous week
according to starting week
day that you chose.

‘Monthly” —the dates will be
setup within cument
calendar monith.

cooie T o]

Accounting Period
Click Next to continue.



Database

This page allows you to set the Time View and specify the various folder locations.
»  Time View

Advanced - Calculates working time considering shift settings.

Simple - Calculates working time without taking into account the shift
settings.

> Time Clock - Uses the physical time clock. You can switch on or off the
connection to the physical time clock device.

If the connection to the time clock is on, Easy Time Control reads the
punch records of employees that come from the time clock and transfers

the details. In other words, the employees use a physical time clock to
punch in and out. If this option is on:

e Simple users of your company having a user name and password

will get the following screen while logging in.

Easy Time CORtFONN x|

. Access |5 Denied.

Access denied to simple users when the time clock connection is on
e Supervisors will be able to login and access the application in
normal mode.

If the connection to the time clock is off, the employees can use the
application to punch records. If this option is off:

Simple users can use Easy Time Control program to punch in and

out. When they login, the following screen is displayed.



Terminal - [Rob Chappell]

Current Date and Time

Dt 1/31/2008
Time:  9:35:00 AM

Accounting Pe

From: 012772008

Ta: 02/02/2008

Submit ] [ Time Card Report... ] [ Close J

Screen for simple users
They can record the time by click Submit. They can also print their
Time Card report. The Time Card report displays the following:

o Break Hours

o Exception Hours

o Actual and Paid Hours
o Overtime Hours

e Supervisors can record their time using the Easy Time Control

application itself, using the New Punch option.

Folders - Defines the location of the Database and folders for automatic
punch data processing. To change the location of the folder, click the
Browse button corresponding to the folder, locate the directory and click
Open. You cannot leave the locations blank, as these are mandatory fields.



Database
Time View Time Clock
() Advanced & On
) Simple O ofF
: Folders
. - \ork Folder:
|C:"-.F‘roglam Files"Easy Trinity".Easy Time Control\Work Folder | [ Browse... ]

= History Folder:
|C:"-.Prc-g|am Files".Easy Trinity".Easy Time Control*History Folder | [ Browse ... ]

- Database Path:
|C:"-.F‘roglam Files"Easy Trinity".Easy Time Control\Data". TrComm | [ Browse ... ]

- Required fields

ks

Descripti
This Wizard will help you
manage your program
Settings.

"Advanced’ - working time
will be calculated
considering shifts settings.

"Simple' - working time will
' be calculated without A
|considering shifts settings. |
5 |
You can change a path to
your database and define
your folders for automatic
punches processing.

“Work Directory’ —a
directory for automatic
punches that were not
stored in your database.

"History Directory’ -3

[ < Back ] [_ Mext > ]

Database

Click Next to continue. You have completed all the steps in the Setup Wizard. Click

Close Wizard.







Module 2

Exploring the Interface



2.1. Exploring the Main Screen

After using the Wizard to setup the company information, you can go to the main
form. Double-click the icon on the Desktop or Quick Launch or follow the path Start >
Programs > Easy Trinity > Easy Time Control > Easy Time Control. If there are
one or more Supervisors in your company, the Login screen appears. Enter the Login
and Password details. These are the details you assigned while adding a new

employee.

Login

— Login: |i|:|hn|:||:|e |

o Password: |""““ |

Login screen
In the Getting Started dialog, choose the option Open Easy Time Control Main Form.

If you do not want to display the Getting Started screen while opening the application

again, select the option Don’t show this form again. Click OK.

Easy Time Control - Getting Started

Getting Started

Flease make your selection:

If you are a novice user you might use our Setup Wizard which will walk you
i through the whole setup process.
! You can also use a sample Company information in order to test all program

features.
Or you can skip these steps and open the main form of the program right away.

What would you like to do?

) Use Setup Wizard
() Open Sample Company
{®) Open Easy Time Control Main Form

[ ] Dont show this form again

Getting Started Dialog



The main form is displayed. The main form contains three sections.

i File View Reports Optons \Wizards Help

2Ouwdw1Bc0OLDS 3408888 ¢

Employees Hours Employees Hours 2 x
Employee Hours | First Mame | Last Mame
43 Employee Punches 1 8
& Overtime Approval 2 a Evan Scott
3 Handy Gonzales 2410 03:00 00:00 3110 00:00 a i o
Blnshes 4 Kegan Carter 720 013 00:00 1550 00:00 ¥ ey o
4 MNew Punch 5 Lenny Campbell 2510 02:15 00:00 22:55 00:00 g Lengny Campbel
A& Edit Punch Develepment
4 Delste Punch
43l Add Auto Punches
Employee Punches
Actuzl IN | Actusl OUT | Actual Hours | Rounded IN | Rounded OUT | Rounded Hours | Shift
. 08:36:00 2/12/2008 6:50.. 2/12/2008 3:20.. 023:30:00 Day
m@ Shifts 2/13/2008 6:33. 21372008 3:14_ 08:35:00 2/13/2008 6:40. 21372008 3:10.. 08:30:00 Day
2/14/2008 €:33.. 2114/2008 3:21.. 02.48:00 2/14/2008 €:30.. 2/14/2008 3:20.. 02:50:00 Day
g‘ Exceptions 2/15/2008 6:58.. 2/15/2008 3:02.. 02:04:00 2/15/2008 7:00.. 2/15/2008 3:00.. 02:00:00 Day
2/16/2008 6:55. 2/16/2008 3:05.. 08:10:00 2/16/2008 7-00. 2/16/2008 3:00.. 08:00:00 Day
From: | 2/10/2008 b
To 2/16/2008 b
A - [ —— ) G
Ready 2/22/2008 6145 PM UM

The main form



21.1. Menu
The standard menu options are available. Let’s explore the menu options in this
section.

. File - The only option in the file menu is Exit. You can also use the shortcut key
[ALT+X] to exit the application.

el

[@ Exit Aex

File menu
. View - This menu has options to view the Company Structure pane, and the

various toolbars.
View
Company Structure Pane

I Toolbars 3 |

Standard
Options

Reports

Wizards

[T

Employee Hours
Company Structure
Shifts

Exceptions

[

Lock the Toolbars

View menu

o Company Structure Pane - Displays the structure of the companies in a tree
structure, which includes the various departments and the employees in

each department.

o Toolbars - Displays a list of available toolbars. The selected toolbars are
denoted by a tick (v') mark. The toolbars are discussed in detail in the next
section. If the option Lock the Toolbars is selected, you will not be able to

move the toolbars.



Reports — This menu provides access to various reports. You can know more
about the reports in the Reports section.

Reparts

Q_ Time Card

Employees Assignment
Exceptlion Assignment
Onsite Presence

Late Comers

Absence

R o S o W 4

Saved Hours

Reports menu
Options - Using the menu you can set the various options such as the Time,

Date, Accounting Period, and so on.

—

Date and Time

o
b=
=2
o
=1
L

Time Clock

General Restrictions
Accounting Period
Database

Time Calculation

£ oud el

Preferences

Options menu
Wizards - The various wizards are available under this menu. These wizards

help you setup the company information. Refer to Using Setup Wizard for

more information.

Wizards

Company Wizard

1
r

Department Wizard
Employee Wizard

Shift Wizard

Shift Assignment Wizard
Exception Wizard

Exception Assignment Wizard

£ R o= O T e @ F

Settings Wizard

Wizards menu



e Help - This option provides options to get help from the technical support, to

register Easy Time Control software, and so on.

Help

()| Easy Time Control Home Page

": Contact Technical Support

Request Mew Feature

#5| Activate License...

Change Edition 3

@) ~bout Easy Time Contral...

The Help menu
o Easy Time Control Home Page - Loads the home page of Easy Time Control

website.

o Contact Technical Support — Opens the mail client to get in touch with the

Technical Support. You can email your concerns and queries.

o Request New Feature — Opens the mail client with the address and subject

added by default. You can email to request the new features.

o Activate License - Allows you to activate the license. The Select license file
dialog opens. Browse to the location having the license file, choose the file,
and click Open.

o Change Edition — Allows you to change the edition of Easy Time Control. The
sub-menu includes Free, Basic, Professional, and Enterprise. The current
edition is indicated with a tick (v') mark and is disabled. The corresponding

features will be disabled or enabled according to the edition you switch to.

[ e |

u Casy
\'..'*

Time: Control Home Page
Contact Technical Support
Request Mew Feature

Pl Actvate Leoense...

I Change Edition » Free

@ About Easy Time Confrol. Express

Professiona

Help menu



o About Easy Time Control - Provides information about the Easy Time
Control software such as the Version, Database Version, the Mode, and
the days of trial period remaining in case of the trial version. You can also

find e-mail and website address. Click OK to close the dialog.

' About Easy Time Control

Easy Time Control: Enterprise Edition

Version: 4.0.101

\:;rm,rr Datzba=e Version: 12
‘; Erferprize Solutions Inc. Trial Mode
Day(s) remaining: 14

‘website: hitp:fwww easytimecontrol.com

E-mail: supportiE@easytrinity.com

The About dialog

2.1.2. Toolbars

You can opt to show or hide the toolbars. Go to the View menu and click the toolbars
that you want to show. When you move the mouse pointer on any of the icons on the

toolbar, the tool tip displays a short description about the icon.

The selected toolbars are indicated by a tick (v') mark. The following toolbars are
present:

. Standard Toolbar: Contains the option to Exit the application. This option is also

available under the File menu.

: [

Standard Toolbar
. Options Toolbar: Using the menu you can set the various options such as the

Time, Date, Accounting Period, and so on. This toolbar also has the Refresh

icon, which will be disabled where the screen cannot be refreshed.



These are available, except Refresh, under the Options menu.

@

Qw3

i
11

)

Options Toolbar

The following are the icons present in the Options Toolbar:

@

Refresh

Date and Time

(-

©

Time Clock

General Restrictions

Accounting Period

Database

Time Calculation

Preferences

Refreshes the application.

Allows you to set the time format and

defining the first day of the week.

Allows you switch on or off the
connection to the physical time clock
device.

Allows you to define the time interval
between punches and overtime

working hours.

Allows you to define the accounting

period for payroll calculations.

Allows you to define the location of
the database.

Allows you to choose the type of time

calculation.

Allows you to set preferences.



Reports Toolbar: Provides access to various reports. These are the options

present under the Reports menu.

Reports Toolbar

The following are the icons present in the Reports Toolbar:

QJ Time Card Report

@ Employees Assignment Report

Exception Assignment Report

Late Comers Report

9 )
& Onsite Presence Report
0

& Absence Report

‘*?J Saved Hours Report



Wizards Toolbar: Contains various icons to access the wizards. You can also

access these options by going to the Wizards menu.

PREES 444

Wizards Toolbar
The following are the icons present in the Wizards Toolbar:

@ Companies Wizard

Department Wizard

Employee Wizard

Shifts Wizard

o e @

Shift Assignment Wizard

-

Exceptions Wizard

©

Exception Assignment Wizard

Settings Wizard

&,

Employee Hours Toolbar: Contains the options to Add New Punches, Edit, and
Delete Punches. You can also Add Auto Punches.

Employee Hours Toolbar
The following are the icons present in the Employee Hours Toolbar:

-

@j Add new punches.
v Edit existing punches.
@ Delete existing punches.

@ Add auto punches.




Company Structure - Provides options to add, edit, and delete companies,
departments and employees. These options are enabled only when the

company structure is active.

S8 BOEE S8

Company Structure Toolbar
The following are the icons present in the Company Structure Toolbar:

@ Add a new company.

Edit an existing company.

S

Delete an existing company.

Add a new department.

Edit an existing department.

Delete an existing department.

Add a new employee.

Edit the details of existing employees.

Delete an existing employee.

o g & @ &8 @ &



Shifts Toolbar - Contains the options to add, edit, and delete shifts, and also

assign the shifts to the employees.

52588

Shifts Toolbar

These icons are present in the Shifts Toolbar:

5’; Create a new shift.

E’; Edit an existing shift.

5’; Delete an existing shift.

5_\ Assign shifts to the employees.

Exceptions Toolbar - Provides options to create new exceptions, edit and delete

existing exceptions, and assigh the exceptions to the employees.

g 44|d
Exceptions Toolbar
These following icons are available in the Exceptions Toolbar:

Q’i,' Create a new exception.

;é', Edit an existing exception.

g; Delete an existing exception.

@; Assign exceptions to the employees.




2.1.3. Company Structure Pane

If the option View > Company Structure Pane is selected, the structure of the
company you created is displayed in the right pane. You can expand the departments
to view the employees.

Company Structure a x
C

r

4B
&

les
Dominic Thomp=zon
Ewvan Scott

2
-
£ Handy Gonzales
2
]

&

Kegan Carter
Lenny Campbell
= a Development

a Jean Wiliams

ﬂ Jerold Moore

ﬂ Jerri Jackzon

a Maddizon Robinzon

£ Rob Wright

The company structure

To hide this structure, click the AutoHide @ icon. You will see a tab named Company

Structure and the details will be displayed when you move the mouse over the tab. To

disable the auto hide feature, click E|



2.1.4. Understanding the Layout of the Main Form

As discussed earlier, the main form is divided into three sections: the left pane
containing various options and the accounting period, the center pane where the
details are displayed and actions are performed, and the right pane showing the

company structure.

The image shows the options on the left pane.

Employees Hours

Employee Hours

@ Employee Punches
£ QOvertime Approval

Punches

@ Mew Punch
&l

=1

apl Add Auto Punches

L Employees Hours

!_%.Jl Reports

ﬁ Company Structure

[T shifts

5:!‘} Exceptions

L

Options

-]
-

Accounting Period

From: | 1/14/2008 v |

To: | 1/27/2008 v |

When you click each tab, the options of the active tab are displayed and the center
pane also changes accordingly. For instance, when you click Company Structure the

details of the employees are displayed in the center pane.



B Easy Time Control Enterprise

I File View Reports Options Wizards Help
ROwh 310008208 32000904838 ¢ 848 & if
Employees Hours o S

Employee Hours First Name Last Name Punches |Breaks Exceptions i =l _‘;‘3 ABC
& Emolayes Punctica 1= Dominic Thompson _|4150 — [0345 o000 | 00 e e
 Overime Aparoval 2 Evan Scott 33:30 03:00 D000 30:30 00:00 T ey
' 3 Handy Gonzales 3410 03.00 00:00 2110 00:00 g :"":5;"“ =
Bk 4 Kegan Carter 720 03 00:00 1550 00:00 z S
4§l Mew Punch 5 Lenny Campbell 2510 02:15 00:00 Z2:55 00:00 a LE:FI‘{ Campbel
& Edit Punch & Development
| Delste Punch
#jl Add Auto Punches
(., Employees Hours
L%} < >
'::d Reports Employee Punches
ﬁ Actual IN Actual OUT Actual Hours Rounded IN Rounded OUT | Rounded Hours | Shift
Company Structure
" 2 2 RS 2/12/2008 3:24.. 08:36:00 2(12/2008 6:50.. 21122008 3:20.. 08:30:00 Day
ﬁ Shifts 2/13/2008 6:39.. 21372008 3:14.. 08:35:00 2/13/2008 6:40. 21372008 3:10.. 08:30:00 Day
e i 2142008 6:33. 2/14/2008 3:21.. 08:48:00 2/14/2008 6:30.. 2/14/2008 3:20.. 08:50:00 Day
g‘ Exceptions 2/15/2008 6:58.. 2/15/2008 3:02. 08:04:00 2/15/2008 7. 2/15/2008 3:00.. 08:00:00 Day
|l 2/16/2008 6:55.. 2/16/2008 3:05.. 08:10:00 2162008 7:00.. 2/16/2008 3:00.. 08:00:00 Day
-, Options
»
Accounting Period
From:
To
< I | >
Ready 2/22/2008 £:45 PM NUM

Main form showing company structure

B»
In the left pane, click the Configure buttons ~ icon and click Show Fewer

buttons. Only a few tabs will be available and the remaining tabs will be displayed as
icons. Click the Configure buttons icon again and choose Show More buttons to

display the tabs.

Employees Hours

Employee Hours

QJ Employee Punches
& OQvertime Approval

Punches

.QJ New Punch
&
2

JJ Add Auto Punches

Left pane showing fewer buttons






Module 3
Setting up Options



In Module 1, you learned to use the_Setup Wizard to create the company information.
In the forthcoming modules, you will learn to setup the company information using the

main form available. This module explains the steps to set the various options.

3.1. Options

This section explains the steps to set up various options in Easy Time Control. To

:} Options

access the options, click the Options

tab from the left pane. If the tab

is not visible, click the Options - icon. The various options available are:
¢ Date and Time
¢ Time Clock
¢ General Restrictions
e Accounting Period
e Database
e Time Calculation

e Preferences
3.1.1. Date and Time

This option is for setting the time format and defining the first day of the working

week. Click @ Dateand Time from the left pane or follow the menu path Options >

Date and Time. The changes can be made in the center pane.

Date and Time

Time Format
(%) Civilian Time (AM/PM) ) Wilitary Time (24 hrs)
First Day of Week

Default System w

OK ] [ Cancel

Date and Time option



There are two time formats available: Civilian Time (AM/PM) and Military Time
(24 hrs). The default format is the civilian time. Select the required option.

Choose a day from the First Day of Week dropdown list. You can also set the first
day of the week to be the default system. After setting the time format and first day of
the week, click OK.

3.1.2. Time Clock

Click @ TimeClock from the left pane or follow the path Options > Time Clock.
i Time Clock

5 5 If you 2elect thiz option, your Easy Time Control program will read employses.

B @ punch recerds that come from your time clock and transfer the data into vour

Connection to Time Clock OFF O If you select thiz option, your Easy T_ime Contrel program will not read employses
punch recerds that come from any time clock.

: Folders
Waorking Folder. |C:‘.Pr0gram Fileg\Easy Trinity\Easy Time ControlWork Folder | [Bro-.-.'as...]
History Folder: |C:‘.Program Filez\Eazy Trinity\Easy Time ControlHiztory Folder | Browse...
{ options
Time Clock Length: |2 El:

QK ] [ Cancsl

Time clock
You can switch on or off the connection to the physical time clock device.

e If the connection to the time clock is on, Easy Time Control reads the punch
records of employees that come from the time clock and transfers the
details. In other words, the employees use a physical time clock to punch in
and out. If this option is on:

o Simple users of your company having a user name and password will

get the following screen while logging in.

. Access |5 Denied.

Access denied to simple users when the time clock connection is on



o Supervisors will be able to login and access the application in normal

mode.

e If the connection to the time clock is off, the employees can use the

application to punch records. If this option is off:

o Simple users can use Easy Time Control to punch in and out. When
they login, the following screen is displayed.

Terminal - [Rob Chappell]

Current Date and Time

Dt 1/31/2008
Time:  9:35:00 AM

Accounting Pe

From: 012772008

Ta: 02/02/2008

Submit ] [ Time Card Report... ] [ Close J

Screen for simple users
They can record the time by click Submit. They can also print their

Time Card report. The Time Card report displays the following:
= Break Hours
= Exception Hours
= Actual and Paid Hours
= Overtime Hours

o Supervisors can record their time using the Easy Time Control

application itself, using the New Punch option.



Easy Time Control requires two folders if a physical time clock is used: Work Folder
and History Folder. By default, these folders are located within the installation
directory. To change the default folders, click the respective Browse button, look for
the folder, and click OK. If you want to create a new work or history folder, click the
Make New Folder button.

Browse For Folder @@

= [ Easy Triniky .
|5 Easy Card Creator
= |) Easy Time Conkrol

[ Data
|=) Histary Folder
[ Icons
[ ru
) Work Folder
[ Easy Time Logs

s -

< ¥

hd

Make Mew Folder ] [ (o]4 i [ Cancel

Browsing for a folder

The time clock devices have a standard number of digits allowed in the IDs. The
default value for the Maximum number of digits allowed to be used for IDs in
your time clock device is 8.

Note: The Folders and Options sections will be disabled if the option Connection to

Time Clock OFF is selected.

Click OK after making all changes.



3.1.3. General Restrictions

Under General Restrictions, you can define the working hours. Click

du General Restrictions from the left pane or follow the path Options > General

Restrictions.

General Rectrictions

! GeneralRestrictions

Minimum Interval Between Two Punches in Minutes:

—
i

— Overtime

Monday:
Tuesday:
\Wednesday:

Thursday:

@ Regular Weekly Waring Time

{3 Regular Daily Working Time

ELE

3730
Friday: I:I
Saturday: I:I
Sunday: I:I

Setting General Restrictions

[ OK ] [ Cancel

Easy Time Control allows you to define the minimum interval between two punches.

You can calculate overtime either based on weekly overtime or daily overtime. After

making changes, click OK.



3.1.4. Accounting Period

This option allows you to define the accounting period for payroll calculations. Click

<& Accounting Period £-om the |eft pane or go to Options > Accounting Period.

After setting the accounting period, click OK.

(%) User Defined

From | 1/21/2008 »| To

O Weekly

) Bi-Weekly
Period Start: QOr

) Monthly

Accounting Period

Accounting Period Type

specify the From and To dates.

Weekly - Considers weekly accounting period.

specify the starting date.

Monthly - Considers monthly accounting period.

oK ] l Cancel

Accounting Period
There are four accounting period types available:

User Defined - Allows you to customize the period. Select the option and

Bi-Weekly — Considers bi-weekly accounting period. Select the option and

The Weekly and Bi-Weekly periods start from the First Day of Week that you defined in

the Date and Time section.



3.1.5. Database

The details such as punch records, shifts, shift assignments, and so on are stored in a

database. This option allows you to define the location of the database. Click

9 Database from the left pane or go to Options > Database.

 Database Settings
Database Path: |C:"-.Prc-glam Files“Easy Trinity"Easy Time Control*Data"TrCommon mdb | [ Browse. .. l
Check Connection
l oK ] l Cancel ]

Database settings
By default, the database is located in the installation folder. In the center pane, click

Browse, locate the database, and click Open. After specifying the location, click OK.
To check the connection to the database, click Check Connection. If the connection is

correct, a message popup is displayed.

Easy Time Control Enterprise r5__<|

o | J Connection to the database was successful

Message popup



3.1.6. Time Calculation

To access the time calculation, click [ Time Calculation o0 ¢5]jow the path Options >

Time Calculation.

Time Calculation

i Time calculation

(® Advanced {Using Shifts) O simple (Pair Only)

[ OK ] [ Cancel ]

Time Calculation
Two types of time calculations are available. If Time Calculation is set to Advanced

(Using Shifts) then the rounding rules be applied to the round punch time within the
intervals defined in Shifts Wizard under Rounding Rules section or in the Shifts - New
Shift/Edit Shift section of the program, provided employees have to be assigned to this

shift. If the option is set to Simple (Punch Pair Only), the next punch will be
considered as the time out. In this case all punches will be shown at actual punch time
(without considering any rounding rules). Click OK after selecting the required time

calculation.



3.1.7. Preferences

This section allows you to choose between small and large buttons. Click
¢y Freferences 5 g0 to Options > Preferences.
Preferences
Preferences
l@Lﬂrge Buttons {:}SmaIIButtclns

Show Getting Started Form

[ oK l [ Cancel l

Setting Preferences
You have to the option of displaying large or small buttons. To skip the Getting Started

dialog, which is displayed while launching the Easy Time Control application, de-select

the option Show Getting Started Form. Click OK after making changes.



Module 4

Managing Company Structure



After setting the options the next step is to setup the company structure. This module

explains the procedure to create the company structure, without using the Wizard.

Click the Company Structure tab from the left pane. If the tab is not visible, click the

Company Structure = icon.

4.1. Manage Company

There are options to add a new company, edit the details of the existing company, and

delete the company.
4.1.1. Adding a Company
Follow these steps to add a new company:

4 C|iCk’:'_i| News Company
New Company

= Company ID:  |0002
- Company Mame:|*7Z Incorporated
Abbreviation: XL
Address1:
Address2: |
City:
Region/Zip Code:
Country:

Description:

= Required fields [ QK ] [ Cancel

Form to enter details of new company
5. Provide the Company ID. This should be a numeric value and be unique. A

default value will be displayed, which can be changed. This is a mandatory
field.

6. Enter the Company Name. This is also mandatory.
7. Mention an Abbreviation.

8. Specify the address details.



9. Provide a Description.

10. Click OK.

Note: The OK button will be enabled, only when the mandatory fields, denoted

by asterisk (*) are filled in.
4.1.2. Editing a Company

To edit the details of the company:

1. Choose a company from the Company Structure on the right pane.

2. Click @ EditCompany The details of the company will be loaded in the form.

Edit Company

= Company |D: ‘ 0001

- Company Name:‘AEIC

Abbreviation: ‘

Address1: ‘

Address2; ‘

City: ‘

Region/Zip Code:‘

Country: ‘

Description: ‘

= Reguired fields

Editing details of the company
3. Make the necessary changes.

4. Click OK.




4.1.3. Deleting a Company

To delete a company:

1. Choose a company from the Company Structure on the right pane.

2. Click & Delste Company  The company will be deleted on confirmation.

Confirm Company Delete

- 1
b) Are you sure you want to delete company ABC?

fes l [ Mo

Confirmation for deleting the company

4.2. Manage Department
You can add a new department to a company or edit and delete the existing

department details.
4.2.1. Adding a Department

To add a new department:

e Choose a company from the Company Structure on the right pane. The new

department will be added to this company.

e Click 8 MNew Department fr-om the left pane.

i New Department %

= Department Mame: |

= Required fields

Adding a new department
e Enter the Department Name. The department name should be unique.

e Click OK. The new department will be added to the company. Notice the
Company Structure displayed in the right pane.



4.2.2. Editing a Department

To edit the name of an existing department:
e Select the Company from the Company Structure on the right pane.

e From Company Structure tree, click the department that has to be edited.

e Click @ EditDepariment  from the left pane. The name of the department is loaded

in the form.

! Edit Department X

|
= Required fields

Editing an existing department
e Modify the Department Name.

= Department Mame:

¢ Click OK.
4.2.3. Deleting a Department
To delete an existing department:
e Choose a company from the Company Structure on the right pane.

e From Company Structure tree, click the department that has to be deleted.

e Click @ DeiteDepartment  from the |eft pane. The department will be deleted on

confirmation.

Confirm Department Delete

Adminstration?

i)_/) Are you sure you want to delete department

Confirmation for deleting a department



4.3. Manage Employee

You can manage the list of employees in various departments.
4.3.1. Adding New Employees

To add a new employee:

e Choose a company from the Company Structure on the right pane.

e Click @ NewEmployee t-om the left pane or the New Employee ﬁ icon from

the Company Structure toolbar.

New Employee

- Department: | Development 26

- Employee ID: |11

- First Mame: Chris

= Last Mame: Simpson
Role: Supervisor B
Login: |
Password:

= Active:

=~ Reguired fields QK ] [ Cancel

Adding a new employee
e Choose a Department.

e Enter the Employee ID. This should be a humeric value and be unique. A default

value will be displayed, which can be changed.
e Mention the First Name and Last Name.

e Choose the Role of the employee. You can assign two different roles to the
employees: Supervisor and Simple User. You should assign the role of supervisor

at least to one employee initially. You can also omit assigning roles.
e Provide a User Name and Password.

e Specify whether the employee is Active.



e Click OK. The OK button will be enabled, only when the mandatory fields,

denoted by asterisk (*) are filled in.
4.3.2. Editing Existing Employees
To edit the employee details:
e Choose a company from the Company Structure on the right pane.

e Select the employee from the list.

=y
e Click &% EditEmployee f-om the left pane or the Edit Employee 74 icon from the

Company Structure toolbar.

i Edit Employee =

= Department: | Development i

= Employee ID: E

=~ First Mame: Jerri

= Last Mame: Jackson
Raole: Mot Defined e
Login:
Password:

= Active:

= Required fields

Editing details of existing employee

e Modify the details.

e Click OK to save the changes. The details will be updated in the list. The OK
button will be enabled only when the mandatory fields, denoted by asterisk (*),

are filled in.



4.3.3. Deleting Employees

To delete an employee:
e Choose a company from the Company Structure on the right pane.

e Select the employee from the list.

e Click & DekteEmpbyee  from the left pane or the Delete Employee & icon

from the Company Structure toolbar.

e The employee will be deleted on confirmation.

Confirm Employee Delete

.t
%) Are you sure you want to delete employee Jemn Jackson?

| [ Mo

Confirmation for deleting an employee

Note: If you make changes to any form, and without saving the details if you try to
access any other form, a dialog box will be displayed.

Easy Time Control Enterprise

Information dialog
Click Yes if you want to continue. Note that the changes will not be saved. Click No to

go back to the form and save the changes.



Module 5
Managing Shifts and Exceptions



In Module 4 you created the company structure, by defining companies, adding
departments, and assigning employees to the departments. In this Module, you will

define shifts and exceptions and assign them to the employees.

5.1. Shifts

You can add new shifts, edit, or delete existing shifts. To access these options, click

E_, Shifts
the Shifts

tab from the left pane. If the tab is not visible, click the

Shifts & icon.
5.1.1. Adding Shifts

To add a new shift:

e Choose the Company for which you want to define the shift.

e Click & New Shift from the left pane or the New Shift 5 icon from Shifts

toolbar.
i New Shift
“Shift Mame:  |Day Apply From: 21872008 b
Tirne From: 07:00 AM s Tirne Ta: 03:00 PM s
Calar: [ Aqua w
—Punches Rounding Rules
Shift partitions i {10 3: minutes intervals.
Punch [N rounds to beginning time of an interval if less than: 5 =1 minutes passed from beginning of interal.
Otherwize it will round to end of the interval.
I ; ; ) 5 = minutes passed from beginning of interval.
Punch OUT rounds to beginning time of an interval if less than: 37 Dtherwitse it vl round to end of the interval
Punch [N will be registered within the shift if it will take place less than: |30 3: minutes before the shifts starts.
Punch OUT will be regiztered within the shift if it will take place less than: [30 Elj minutes after the shift ends.
Break/Lunch Time: | 30 minutes to be deducted from shift tire.
[ Simulate. . I [ ak. l [ Cancel

=Fequired figlds

Adding new shifts
e Provide the Shift Name.



Specify the date from which the shift is applicable. By default, the current date

will be displayed, which can be changed.

Choose the shift timings.

Select the Color for the shift details.

Set the Punches Rounding Rules.

o

The shifts can be divided into intervals. Set the interval by selecting the

number of minutes in the Shift partitions in: dropdown list.

Choose the options for rounding the Punch INs and Punch OUTs.

For instance, consider that the shift interval is set to 10 minutes, the
Punch IN and Punch OUT round options are set to 5 minutes each.
Scenario 1

Consider that for a shift beginning at 10:00 AM, an employee punches
IN at 10.03 AM. Here the Actual Punch IN will be 10:03 AM and the
Rounded Punch IN will be 10:00 AM.

Scenario 2

Now if another employee punches IN at 10:07 AM for the same shift, the
Actual Punch IN will be 10:07 AM, whereas the Rounded Punch IN will be
10:10 AM, which is the end of the interval.

Choose the options for indicating the grace the Punch IN and Punch OUT
timings. These options are used to indicate overtime. If the values are
set to 0 minutes, it indicates that overtime will not be considered.

For instance consider that the grace Punch IN time is set to 30 minutes.
Scenario 1

If an employee punches in at 6:32 AM for a shift beginning at 7:00 AM,
the Actual IN time will be 6:32 AM and the Rounded IN time will be 6:30
AM. The grace time will be considered for overtime.

Scenario 2

If an employee punches in at 6:26 AM for a shift beginning at 7:00 AM,
the grace time will not be considered for overtime. In addition, the icon
o will be displayed in the Status column indicating a problem with the
Punch IN.



Scenario 2

Now if another employee punches IN at 7:07 AM for the same shift, the
Actual Punch IN will be 7:07 AM, whereas the Rounded Punch IN will be
7:10 AM, which is the end of the interval.

Choose the options for indicating the grace period for the Punch IN and
Punch OUT timings. These options are used to allow an employee to
punch before the beginning of the shift or after the end of the shift, and
still be considered as punched within the shift timings. The grace time
will be considered as overtime. If the grace period values are set to 0
minutes, it indicates that every punch IN before the beginning of the
shift and the grace period will not be included in the shift timings. This
also applies to any punch OUT that occurs after the end of the shift.

For instance consider that the grace Punch IN time is set to 30 minutes.
Scenario 1

If an employee punches IN at 6:32 AM for a shift beginning at 7:00 AM,
the Actual IN time will be 6:32 AM and the Rounded IN time will be 6:30
AM. The grace time will be considered for overtime.

Scenario 2

If an employee punches in at 6:26 AM for a shift beginning at 7:00 AM,
the punch will not be considered as recorded within the shift and the
grace time will not be considered for overtime. In addition, the icon @
will be displayed in the Status column indicating a problem with the

punch IN.

For instance consider that the grace Punch OUT time is set to 30
minutes.

Scenario 1

If an employee punches in at 3:23 PM for a shift ending at 3:00 PM, the
Actual OUT time will be 3:23 PM and the Rounded IN time will be 3:20
PM. The grace time will be considered for overtime.

Scenario 2

If an employee punches out at 3:31 PM for a shift ending at 3:00 PM,
the grace time will not be considered for overtime. In addition, the icon
o will be displayed in the Status column indicating a problem with the
Punch OUT.



Mention the Break/Lunch Time that has to be deducted from the shift

time.
e Click OK to save the shift details.
To simulate the various punch IN and punch OUT timings, click Simulate. Enter the

Punch IN and Punch OUT timings and click Calculate to see how the timings are
rounded off based on the Punches Rounding Rules you had set.

Simulator r>_(|

Punch IN: Rounded To: [07:00:00 AM
Punch OUT: Rounded To: |02:30:00 PM

[ Calculate ] [ Cancel ]

Simulating punches



5.1.2. Editing Shift Details
To edit a shift:

e Choose a company from the Company Structure on the right pane.

e Select a shift from the list.

e Click & Editshift f-5m the left pane or the Edit Shift E" icon from Shifts

toolbar.
: Edit Shift
“Shift Mame: Apply From: 2/18/2008 b
Tirne Framm: 07:00 AM & Tirne To: 0200 P s
Calor: [ Aqua v

r—Punches Rounding Rules

Shift partitionz in: {10 3: minutes intervals.

Punch IM rounds to beginning time of an interval if less than: 5 =1 minutes passed from beginning of interval.
Otherwize it will round to end of the interval.

I ; ; ) 5 = minutes passed from beginning of interval.
Punch OUT rounds to beginning time of an interval if less than: | Othermise it il raund ta end of the interval
Punch [N will be registered within the shift if it will take place less tharn: |30 3: minutes before the shifts starts.

Punch QUT will be registered within the shift if it will take place lezz than: (30 Elj minutes after the shift ends.

BreakLunch Time: | 30 minutes to be deducted from shift time.

= Required fields

Editing shifts
e The details of the shift will be loaded in the form. Make necessary changes.

¢ Click OK. This button will be enabled only if you make changes to the form.



5.1.3. Deleting Shifts

To delete a shift:

e Select a shift from the list.

e Click & Delte=hift  from the left pane or the Delete Shift @ icon from Shifts
toolbar.

Confirm Shift Delete

b) Are you sure you want to delete shift Night?

flas l [ MNo

Confirmation for deleting a shift
e The shift will be deleted on confirmation.

In the left pane, select the option Show Shift History to view the history details of a
particular shift.

To display the inactive shifts, select the option Show Inactive Shifts.

5.2. Shift Assignments

The next task after defining the shifts is to assign it to employees.
To assign shifts to the employees:
e Choose a company from the Company Structure on the right pane.

e Select an employee from the list.

e Click & Shift Assignments from the left pane or Assign Employee to Shift @
icon from the Shifts toolbar.
Note: The icons in the Shifts toolbar will be disabled when you are in the Shift

Assignment page.



Shift Assignments

Comgany.  2EC L

Ermplionome 15 First Name Last Name Departrmen Seles

Assigning shifts to employees
For each day assign a shift to the employee. You cannot assign two shifts to an

employee on the same day. When you assign shifts, the calendar will be
marked in the color chosen for the shift.
Click a date and drag the dates to assign a shift to multiple days on the
calendar control.
Choose the Auto Punches options. In case of missing punches, this option
automatically assigns punches to the shift start time, shift end time, or both.
This option reduces the workload on the supervisors as they do not have to
assign missing punches manually. If the employee shift is set to IN, OUT, or
IN/OUT, then the Add Auto Punch feature can be applied to employees during
shift assignment process. If you choose:

o In - The Add Auto Punch option will add missing IN punches

o Out - The Add Auto Punch option will add missing OUT punches

o In/Out - The Add Auto Punch option will add both missing IN and OUT

punches.

Note: The Auto Punches setting will be applied to missing punch records after
this option is set; however, this feature cannot be applied to the history

records.

Click Apply.



To delete the existing assignments for an employee, select the employee, and enable

the option Delete Existing Assignments.

5.3. Exceptions

There are instances where there could be exceptions to the general shift hours. The
Exception Rules indicate when the employees should be paid for a set number of hours
even though it was their day off, holiday, or they did not work the full shift on those
days. You can create many exception rules, using different color indication. The
program will automatically recalculate the working hours considering the rules applied.

You can apply the rules using Exception Assignment functionality.

This section explains the steps to create exceptions, edit, and delete exceptions. You

will also learn to assign these exceptions to employees.

;!.{ Exceptions
To access the options, click the Exceptions | = tab from the left pane. If

i
the tab is not visible, click the Exceptions = icon.

5.3.1. Creating Exceptions
To create an exception:

e Choose a company from the Company Structure on the right pane.

e Click 4@ MNewException f-om the |eft pane or the New Exception g’ icon from

the Exceptions toolbar.

New Exception x
= Exception Mame: Daily Paid Hours: B :
Description: Color: | Aguamarine “

~Required fields

Adding new exceptions
e Enter the Exception Name, which is mandatory.

e Provide a Description.
e Choose the Daily Paid Hours and the Color.

e Specify a Color to mark the exception.



e Click OK. This button will be enabled only when the mandatory fields, denoted by

asterisk (*), are filled in.

5.3.2. Editing Exceptions
To edit an existing exception:
e Choose a company from the Company Structure on the right pane.

e Selection the exception that has to be edited.

. . |
e Click # EditException o the Edit Exception é icon from the Exceptions

toolbar.
i Edit Exception x
= BException Name: |H.:.Iida~,- | Daily Paid Hours: |2 =
Description: | | Color: ||:| Aqua “ |

~Required fields

Editing exceptions
e Modify the necessary details.

e Click OK.
5.3.3. Deleting Exceptions
To delete an exception:
e Choose a company from the Company Structure on the right pane.

e Selection the exception that has to be edited.

. |
e Click 4 DekteExcepton  or the Delete Exception d icon from the Exceptions

toolbar. The exception will be deleted on confirmation.

Confirm Exception Delete

- 1
b) Are you sure you want to delete exception Holiday?

fes l [ Mo

Confirmation for deleting an exception



5.4. Exception Assignments

After creating the exceptions you can assign them to the employees.
To assign the exceptions to the employees:
e Choose a company from the Company Structure on the right pane.

e Select an employee from the list.

e Click 4 ExceptionAssignments f-om the |eft pane or the Exception Assignment
o)

existing exceptions will be displayed.

icon from the Exceptions toolbar. The Employees, calendar, and the

Exception Assignments

Company: | 257 -
Exgloyves 1D [ Lasi Hame Daparymact -
7] [— [ [ [ml
L ¥
Assignments
a4 Jsnuary 2008 Febrysry 2002 March 2008 *
5 M T T F 5 $ M T W T F § § M T T F &
N
i 4 5 & T & 9 2 i 4 5 & 7 8
-] : 1¥ 1 15 1k ] ] FR - L 11
7% 1B N 1o I # 7 B oH 0 o
& XM 3 oI - T - - 3 oM B N O B »
X i
Exceptir Descnpen Cadar

Assigning exceptions
e On the calendar, click the dates on which you want to assign exception to the

selected employee. The dates will be marked in the color assigned to the

exception.



e You can use the drag and drop technique to assign an exception to multiple

days on the calendar control.
e Click Apply.
To delete any existing exceptions, select the Delete Existing Exceptions checkbox
present on the left pane.



Module 6

Employee Hours



The Employee Hours option displays the punches, breaks, exceptions, overtime, and

so on related to the employees.

Select a company from the Company Structure on the right pane. You can select a
Department from the tree structure. The Employee Hours of the employees in this
Department are displayed. The details displayed include:

e Punches - The number of hours between the Punch IN and Punch OUT.

e Breaks - The break hours availed by the employee.

e Exceptions - Any exceptions qualified as exceptions assigned to the employee.
e Total hours - The total hours after deducting the breaks from the punch hours.
e Overtime - The extra time put in by the employee.

e Status - The status of the employee. The icon @ in the Status column indicates
missing punches for the employee. This feature allows the Supervisor to make
manual changes by filling the missing punches using the Add Punch or Add Auto
Punch feature.

Employees Hours

1D First Name Last Name Punches | Breaks Exceptions Total Owertime Status
1 Dominic ___|Thompson _[4150 o345 Jooo0  [3805 (o035 |

2 Evan Scott 33:30 03:00 00:00 30:30 00:00

3 Handy Gonzales 3410 02:00 00:00 31:10 00:00

4 Kegan Carter 17:20 01:30 00.00 15:50 0000

5 Lenmy Campbell 2510 02:15 00:00 2255 00:00

Employee Hours

6.1. Employee Punches

Click @ Employee Punches f-om the |eft pane to view the punch details of the selected

employee. For each employee the following details are displayed:
e Actual IN - The actual time of punching.
e Actual OUT - The actual time out
e Actual Hours - The actual number of hours.
e Rounded IN - The punch in rounded according to the defined rounding rules.
e Rounded OUT - The punch out rounded according to the defined rounding rules.

e Rounded Hours - The number of hours rounded according to the defined
rounding rules.

e Shift - The shift assigned to the employee.



Employees Hours

10 First Mame Last Mame Punches | Breaks Exceptions Total Owvertime Status
1~ IDominic [Thompson (4150 (0345 o000 |05 o3 |
2 Evan Scott 33:30 03:00 00:00 30:30 00:00

3 Handy Gonzales 3410 03:00 00:00 3110 00:00

4 Kegan Carter 1720 01:.30 00.00 15:50 0000

5 Lenny Campbell 2510 0215 00:00 2255 0000

& Jean ‘williams 34:00 03:00 00:00 31:.00 00:00

7 Jercld Moare 34:30 03:00 00:00 31:30 00:.00

2 Jerri Jackson 3:20 03:00 00:00 3120 00:00

9 Maddison Robinson 34:20 03:00 00:00 3120 00:00

10 Rab \niright 34:50 03:00 00:00 31:50 00:00

Employee Punches

Actual IN Actual QUT Actual Hours Reunded IN Reunded OUT Rounded Hours Shift
2112/2008 6:48 AM 2/12/2008 3:24 PM 08:36:00 211272008 6:50 AM 2112/2008 3:20 PM 08:30:00 Day
2/13/2008 6:39 AM 2/13/2008 3:14 PM 08:35:00 211372008 6:40 AM 2/13/2008 3:10 PM 08:30:00 Day
2/14/2008 6:33 AM 2114/2008 3:21 PM 08:48:00 211472008 €:30 AM 2/14/2008 3:20 PM 08:50:00 Day
2/15/2008 6:58 AM 2/15/2008 3:02 PM 08:04:00 2/15/2008 7:00 AM 2/15/2008 3:00 PM 08:00:00 Day
2/16/2008 6:55 AM 2/16/2008 2:05 PM 08:10:00 2/16/2008 7:00 AM 2/16/2008 3:00 PM 08:00:00 Day

Employee Punches

6.1.1. Adding Punches

If the Connection to Time Clock is off, supervisors can record their time by adding

punches. This also applies in cases where the Connection to Time Clock is ON and

there are missing punches. To add a new punch:

-

e Click @ MNewPunch f-om the left pane or the New Punch S icon from the

Employee Hours toolbar.

i New Punch X

Date | 1/31/2008 v |
10:50:05 AM =

Adding new punch
e The current Date and Time are displayed. If necessary, change the date and

Time (hh:mm:s5}

time.
e Click OK. This date and time will be reflected in the Actual IN column.
The Punch OUT is calculated as follows:

e If Time Calculation is set to Advanced (Using Shifts) then the punches have
to be in intervals: [Shift Start — Grace Period In] to [Shift End + Grace Period

Out] and employee has to be assighed to this shift.



e If Time Calculation option is set to Simple (Punch Pair Only) then the next

punch placed will be reflected in Actual OUT column.

6.1.2. Editing Punches

To edit a punch:

e Select the punch from the Employee Punches list.

e

e Click & EditPunch from the |eft pane or the Edit Punch &) icon from the
Employee Hours toolbar. You can also double click a punch record from the

Employee Punches grid to edit the record.

i Edit Punch X

Date | 1/17/%00E v |

Time (hh:mm:ss) |EE:EE:EE.-’-‘-.T-"I e |

Editing punches

e Modify the punch details.
e Click OK. The changes will be reflected in the list.

6.1.3. Deleting Punches

To delete a punch:

e Select the punch from the Employee Punches list.

-

e Click @ DekEtERunch from the left pane or the Delete Punch 2 icon from the

Employee Hours toolbar. The punch will be deleted after confirmation.

Confirm Punch Delete

- 1
b) Are you sure you want to delete punch?

flas l [ MNo

Deleting punches



6.1.4. Adding Auto Punches

If a punch is missing for an employee, then the Supervisor can activate the Add Auto

Punches option.

To Add Auto Punches:

e Click 4 AddAutoPunches from the left pane or the Add Auto Punch L% | icon
from the Employee Hours toolbar. The Add Auto Punch function adds
Actual IN = Shift Start or/and Actual OUT = Shift End based on Auto Punch

settings to all employees with missing punches for current payroll period.

Note: Auto Punches can be added only within the selected payroll period, between the
date on which the Auto Punches option was set for a particular employee during the
Shift Assignments procedure and the current date.

Assignments

4 February 2008 March 2008 April 2008 »
5 M T W T F ) 5 M T W T F ) 5 M T W T F )

17 13 19 20 21 22 23 18 17 18 19 20 21 2z 20 21 22 23 24 25 26
24 25 26 27 26 23 23 24 25 26 27 28 29 27 26 23 a0 1 2

30 3 5 B 7 8 9

Shift Mon Tue wed Thu Fii Sat Sun Auto Punches olor

Setting Auto Punches during Shift Assignment

6.2. Overtime Approval

Some employees might put in extra hours of work. These hours have to be approved

so that it is taken into account for payroll.
To approve overtime:

e Select an employee from the listing.

e Click & ©vertime fpproval from the left pane.

e Check Approval checkbox. The overtime for the selected employee on that

particular date will be saved automatically to the database.






Module 7
Using Wizards



In the previous modules, you learned to manage the company details manually. Easy

Time Control provides various wizards for making the task of managing the company

details easier. You can also access the Wizards from the Getting Started form that is

displayed when you launch the application.

7.1. Company Wizard

The Company Wizard allows you register your company. To use the wizard:

¢ Follow the menu path Wizards > Company Wizard or click the Company

Wizard

Wizards

&

Add New Company

(=) Company Wizard

() Settings Wizard

icon from the Wizards toolbar.

Descri ptioli-
This Wizard will help you
manage your Compary
information. The first thing
you need to do is to register
your Comparty.

Easy Time Control Express
Edition only supports one
Company. Easy Time
Control Professional Edition
supparts more than ane
Company so you will be
able to add and manage

Jinformation for multiple
HCompanies.

Close Wizard

3

Company Wizard

Note: Based on your edition of Easy Time Control, you will be able to add companies.

For instance, Free and Express Editions support only one company; whereas the

Professional and Enterprise Editions support multiple companies.

¢ Click Next. The Companies Wizard page displays the list of companies.




Wizards

Add New Company

Company 1D | Company Name

| Abbreviation | Address

&

Description |
You can enter your

Company infarmation when
you click “Next™ button.

Company ID is @ numeric
value that you need to
assign to the Company and
it has to be unique.

You will be able to create
- and assign Deparitments

complete this task.

< Back ] L Mext ]

&

List of companies
4, Click Next to add a new company.

&

Description |
You can enter your

Company infarmation when
you click “Next™ button.

Wizards

Add New Company

=Company ID: |1

= Company Nams: |ABCIncur|:|uratetI

Company ID is @ numeric
value that you need to

iation: ABC

ST | i | assign to the Company and
it has to be unique.

Address1: 35, Walter Avenue | A e
You will be able to create

Addrezz2: | | - and assign Departments
and Employess to the

City: | New York | Company after you

2 complete this task.

State/Province | |

Postal/Zip Code: | |

Country: | Usa |

De=cription: | |

Adding a new company




In this page:
> Provide the Company ID. This should be a numeric value and be unique. A
value will be displayed, which can be changed. This is a mandatory field.

> Enter the Company Name. This is also mandatory.
Note: The Next button will be enabled, only when the mandatory fields,

denoted by asterisk (*) are filled in.
> Mention an Abbreviation.
»  Specify the address details.
> Provide a Description.
> Click Next.

You have now registered a company.

7.2. Department Wizard

Click Departments Wizard ﬁ icon from the Wizards toolbar or follow the menu

path Wizards > Department Wizard to create the departments to group the

employees. The number of Departments is unlimited regardless of the Edition. Click
Next.

Wizards E|
Add New Department D Descriptionilll
This Wizard will help you
@B manage your Department

irformation. Now that you
have your Company setup,
you can create
Departments to group your
employees.

O Shift Wizard Easy Time Cortrol Express
Edition does not support
Departments. Easy Time
Control Professional Edition

() Exception Wizard supports more than ane

;:;Departmerrt s0 you will be

able to add and manage
information for multiple

() Settings Wizard Departments.

(%) Department VWizard

() Employee Wizard

e

Departments Wizard



The registered companies are displayed in the dropdown list. Choose the Company to

which you want to add the departments. Click Next.

Wizards

%]

Add New Department NN Descriptionilill

You can enter your
Department information
when you click “Next™
button.

Company: |,'-\_BC Incomarated e |

Department | You will need to select an

existing Company to which
you will assign your new
Department.

(oo ) [en

List of Departments
In the Add New Department screen, enter the Department name. This is a mandatory

field. Click Next.

&

Add New Department NN Descriptionilill

You can enter your
| Department information
when you click “Next™
button.

Wizards

- Department: ||rrf0rrna1i0n Technology|

You will need to select an
existing Company to which
you will assign your new
Department.

e ] [ree ]

Adding a department



You have now added a department. You can add additional departments, or select the
other available options.

7.3. Employee Wizard

Click Employee Wizard a icon from the Wizards toolbar or follow the menu path
Wizards -> Employee Wizard to enter the information of the employees. The
number of active employees that can be maintained at the same time depends on
edition you have purchased. Free Edition is limited to 10 employees; the other editions
can have unlimited number of employees. Click Next.

Wizards E|
Add New Employee D pescriptionllll
This Wizard will help you
O Company Wizard e Y
() Department Wizard Eﬂzliowggﬁsear: ;;nr?yniser
S Ees T licenses you have.
(O Shift Wizard

() Exception Wizard

() Settings Wizard

o

Employees Wizard



From the dropdown list, choose the Company to which you want to add the

employees. Click Next.

Wizards |z|

Add New Employee TR oescriptioniill

You can enter your
Employee infarmation when
you click "Next™ button.

Company: | ABC Incomporated b |

| : You will be able to assign
Employes ID | Department | First Name | Last Name ik e e

existing Department.

e ] [ree ]

List of employees

The Add New Employee page opens.

x|

Add New Employee R pescriptionlill

You can enter your

= Department: ) Employee infarmation when
P |N01 Dl v| you click "Next™ button.

Wizards

- Employee ID: | 1 You will be able to assign
your new Employee to an

existing Department.

* First Mame: |J0hn

|
|
* Last Name: |Doe |
Role: | Not Defined v|
Login: | |
Password: | |
Active:
= Required fields

] )

Adding new employees



In this page:
e Choose a Department.

e Enter the Employee ID. This should be a numeric value and be unique. A value

will be displayed, which can be changed.

e Mention the First Name and Last Name.
Note: The Next button will be enabled, only when the mandatory fields,

denoted by asterisk (*) are filled in.

e Choose the Role of the employee. You can assign two different roles to the
employees: Supervisor and Simple User. If you want to use different roles, you
should assign the role of supervisor at least to one employee initially. You can
also omit assigning roles. If you assign one or more users as Supervisors, then

the Login screen appears when you re-launch the application.

e Provide a User Name and Password. You can assign user name and password
to both supervisors and simple users; however, the difference is explained in
Section 3.1.2. Time Clock.

e Specify whether the employee is Active.
e Click Next.

You have now added an employee to the department.



7.4. Shift Wizard

After adding employees, you can create shifts. Select Shift Wizard from the Wizards

menu or click the Shift Wizards E icon from the Wizard toolbar.

Note: Using the Free or Express Edition of Easy Time Control you will not be able to

create shifts. Only the Professional and Enterprise Editions support the option of

creating shifts.

Wizards

Add New Shift

() Company Wizard
() Department Wizard
() Employes Wizard
() Shift Wizard

() Exception Wizard

() Settings Wizard

3
Description |

Once you have entered
your Employees
irformation, you can create
different Shifts. This Wizard
will help you manage your
Shifts information.

Easy Time Control Bxpress
Edition does not support
Shifts. Easy Time Control
Professional Edition

supports more than one
* Shift so you will be able to

add and manage
information for muttiple
Shifts.

| Close Wizard |

Shift Wizard




Click Next to continue. From the dropdown list, choose the Company and click Next.

Wizards

X
Add New Shift DN oescriptionlill

You can enter your Shift

. irformation when you click
Company: |AEC Incorporated A | “Nesdt™ buttor.

You will be able to input
your Shift parameters.

—

Shift | Date From | Time Frem | Time Te

< Back ] [ Mexnt > Close Wizard

List of shifts

In the Add New Shift page, set the shift parameters:

Provide the Shift Name.

Specify the date from which the shift is applicable. By default, the current date
will be displayed, which can be changed.

Choose the shift timings.

Select the Color for the shift indication.

Set the Punches Rounding Rules.

Mention the Break/Lunch Time that has to be deducted from the shift time.
Click Next.




Shifts Wizard

Add New Shift i

= Shit Name: | Earty Moming Apply From:

Time From:  |0700AM & Time To:
You will be able to input

Color: your Shift parameters.

—Punches Rounding Rules
Shift partitions in: |1E 3: minutes intervals.

xfi Punch IN rounds to beginning  ———jminutes passad from beginning of interval.

|| | timeof aninterval ifless than: I —=10therwise it will round to end of the interval.

Punch OUT rounds to beginning =————yminutes passed from beginning of interval.
time of an interval if less than: I _<10therwise it will round to end of the interval.

Punch IN will be registered within — . :
the shift if it will take place less tharl20 —] minutes before the shifts starts.

Punch OUT will be registered withinfz 7=
the shift if it will take place less than” =

Break/Lunch Time: minutes to be deducted from shift time.

You can enter your Shift
irformation when you click
“Mext™ button.

minutes before the shifts starts.

oo ) (e

Setting the shift

You have created a shift. You can select the Shift Wizard and create more shifts.



7.5. Shift Assignment Wizard
After creating the shifts, click the option Shift Assignment Wizard from the Wizards

menu or the Shift Assignment ﬁ}' icon from the Wizards toolbar.

Wizards

Add New Shift Assignment

() Company Wizard

() Department Wizard

() Employee Wizard

(O Shift Wizard

(%) Shift Assignment Wizard

() Exception Wizard

() Excaption Assignment Wizard

() Settings Wizard

B

%)

TN Descriptionllill

This Wizard will help you
assign existing Shifts to
your Employees.

Please click Next button to
start.

Mext > | Close Wizard

Shift Assignment Wizard




Click Next. In the Shift Assignment page, choose the Company. Select an employee
from the list of Employees. Click Next to assign shifts to the selected employee.

XY1 - Departments Wizard El

Add New Shift Assignment (NN Descriptioniill

First you need to select a
Company from drop down
box at the top of this
Employee ID| First Name | Last Name | Department | Select window.

Doe Mot Defined Then you need to select an
Employee from the list of
your Employees.

Company:  |xvzZ v|

| Press Next button to go to

|the next step where you

" can assign Shifts to the
Employee.

3
|

(oo ) (e

Assigning Shifts

In the Add New Assighment page, select one of the available shifts. Select the Days
the shift has to be assigned to the selected employee. Note that you will not be able to

assign more than one shift to a person on the same day.



Note that only when the Days are selected, the Next button will be enabled. Click
Next.

Add New Shift Assignment 000 Description |

Select a Shift from the list

below and using calendar
1 March 2008 April 2008 r control select days to
E M 9 W L oF S =S M TW T F 5 which you wart to assign
24 25 25 77 I8 19 1 1 2 3 4 the Shift. You can also use
i L ow B o 57 8 9 10 'u 2 week day's check boxes
T it i = below in orderto assign the
3 10 11 15999 15 13 |44 15 18 17 48 13 e e
16 NIERNER 2 20 U 25 comesponding to a week
23 (9903536 27 25| 0 27 BRI - day that you select. These
10 51 =5 7o o= days will be highlighted with

\comesponding colar.

Shift | Mon| Tue| Wed| Thu| Fri| Sat| Sun|Auto Punches|CDIﬂ MNote that you will net be
Morning [N INOUT one Shift to a person on

—3 able to assign more than

the same day. sing this
"Wizard you can also
manage Auto Punches
feature.

Click Next button to save

1

Adding New Assignment

Assign shifts to all employees by selecting the Shift Assignment Wizard again.



7.6. Exception Wizard

There might be instances where you want to specify some exceptions. Exception Rules
indicate when the employees should be paid for a set number of hours even though it
was their day off, holiday, or they did not work the full shift on those days. You can
create many exception rules, using different color indication. The program will
automatically recalculate the working hours considering the rules applied. You can

apply the rules using Exception Assignment functionality. For such exceptions, follow

1
the menu path Wizards > Exception Wizard or click the Exceptions Wizard é

icon from the toolbar. Click Next to continue.

Wizards E|

Add New Exception S | Description |

This Wizard will help you
manage your Exceptions

() Company Wizard

e information.
e
() Department Vizard Easy Time Control Express
) Edition does not support
(O Employes Wizard Exceptions. Easy Time
_ Control Professional Edition
O Shift Wizard supports more than one
Exception so you will be
() Shift Assignment Wizard able to add and manage
information for multiple
(=) Excaption Wizard |Exceptions.

() Exception Assignment Wizard

() Settings Wizard

o

Exception Wizard
Note: Using the Free or Express Edition of Easy Time Control you will not be able to
create exceptions. Only the Professional and Enterprise Edition support the option of

creating exceptions. In the Exceptions page, choose the Company. Click Next.




Wizards

Add New Exception

Company:

|AEC Incomorated w |

Exception

| Description

| Daily paid hours | Color |

x|

Description |
You can enter your
Exceptions infarmation
when you click "Next™
button.

You will be able to input
your Exception parameters.

—

’ < Back ] l Mext J

In the Add New Exception page:

Choosing company

e Enter the Exception Name, which is mandatory.

e Provide a Description.

e Choose the Daily Paid Hours and the Color and click Next.

Wizards

Add New Exception

- Exception Name: |Ho|ida*,'

Description: |

Daily Paid Hours: IB Eﬁ

- Reguired fields

Color

X]

Description |
You can enter your
Exceptions infarmation
when you click "Next™
button.

You will be able to input
your Exception parameters.

<Back | [ Nei> |

Adding New Exception




Now you have registered your company, created departments, added employees,

defined shifts, assigned shifts to employees, and created exceptions.

7.7. Exception Assignment Wizard
After creating the exceptions you can assign the exceptions to the employees. click the

option Exception Assignment Wizard, and click Next.

Wizards [z|

Add New Exception Assignment — Descriptl'm

This Wizard will help you
assign your custom
Exception Rules that you

() Company Wizard

© Department Wizard created earier to your
Employees.
() Employes Wizard H
Please click Next button to
() Shift Wizard start.

() Shift Assignment Wizard
() Exception Wizand

(%) Exception Assignment Wizard

() Settings Wizand

e

Exception Assignment Wizard
In the Add New Exception Assignment page, choose the Company. Select an
employee from the list of Employees. Click Next to assign exceptions to the selected

employee.



Wizards

Add New Exception Assignment ]l Description |

First you need to select a
Company from drop down
box at the top of this

I Employes ID| First Name | Last Name | Department | Select window.
Doe Mot Defined Then you need to select an

Employee from the list of
your Employees.

Company: |_A_BC Incomorated B |

| Press Next button to go to

the nest step whers you
can assign Shifts to the
Employee.

| L
b

(oo ) (e

Choosing Employees
In the next screen, select one of the available exceptions. Select the Days, from the

calendar, the exception has to be assigned to the selected employee.

Note that only when the Days are selected, the Next button will be enabled. Click
Next.

X]

X

Wizards

Add New Exception Assignment 0] Description |

Select an Bxception Ruls
1 March 2008 April 2008 K from the list below and
5 M ad W T F 5 S M T WTF 5 using calendar control
24 25 26 237 2B 29 1 1 2 3 4 5 select days to which you
T T want to assign the
.. § i g 3 A0 dy id Exception. These days wil
9 10 11 13 14 15 13 14 15 16 17 18 19 be highlighted with
1617 18 19 0 21 22 0 21 2 23 M 25 X% comespanding color.
23 24 25 26 27 25 29 27 2% 29 30 1 2 3
4 5 5 7 8 9 1 MNote that you will not be
30 AN : 0 g 9 10 4
able to assign more than
) one shift to a person on the
[~ Exceptions same day.
Exception | Calor
— Click Next button to save
the changes you hawve
made.
< E

Adding New Assignment



7.8. Settings Wizard
The Settings Wizard helps you manage your general program settings. Click Settings
Wizard from the Wizards menu or the Settings Wizard icon from the toolbar. Click

Next to continue.

Wizards [5_(|
Wizards NN pescripioasiill
This Wizard will help you
) Manage your program
) Compary Wizard Semnggs.:.ra HIL

() Departments Wizard

() Employees Wizard
() Shift Wizard
() Shift Assignment Wizard

() Exception Wizard

(%) Settings Wizard

< Back Next = | Close Wizard |

Settings Wizard



7.8.1. Date and Time

This page allows you to set the time and week format.
e Time Format - Sets the time format. There are two options available:
o Civilian Time - Displays the time in the AM/PM standard format
o Military Time — Displays the time in the 24 hour military form.

e First Day of Week — Allows you to define the day of the week that would be the
starting day for payroll calculations.

Settings Wizard

Date and Time Descriptions |
This Wizard will help you
Time Format Manage yaur program
Settings.
(® Civilian Time (AMPI} O Wilitary Time Please sslect Civilian
; Time' in order to have
First Day of \Week AM/PM time standard.
Plzase select "Military Time'
e L 2 \in orderto have 24-hour
[time standard. B
(%) Monday () Friday [

() Tuesday () Saturday -
your payroll period.

() Wednesday () Sunday

[ < Back ] [ Neat > Close Wizard

Date and Time setup
After choosing the relevant options, click Next.



7.8.2. Accounting Period

This page allows you to define the accounting period for payroll calculations:

e User Defined - Allows you to customize the period. Select the option and
specify the From and To dates.

e Weekly - Considers weekly accounting period.

e Bi-Weekly - Considers bi-weekly accounting period. Select the option and

specify the starting date.

e Monthly - Considers monthly accounting period.

Settings Wizard

Deﬁcriptim
Thig Wizard will help you

Accounting Period Type MENage your program
Settings.

Accounting Period

Q U=er Defined
‘User Defined’ in order to

; select what dates will be
i | | 19 | - starting and ending dates
for your payrall period.
(&) Weskly
“Weekly' =0 your weekly
2 - \payroll period will start from
O siweeky 3";weekda',r of your selection
Peried Start: 1/7/2008 Or 12/31/200 i-Weekly' so you can set
Y Bstating date to the cument |
) Monthly or previous week
according to starting week
day that you chose.

T T

Accounting Period
Click Next to continue.



7.8.3. Database

This page allows you to set the Time View and specify the various folder locations.

e Time View

o Advanced - Calculates working time considering shift settings.

o Simple — Calculates working time without taking into account the shift

settings.

e Time Clock - Uses the physical time clock.

e Folders - Defines the location of the Database and folders for automatic punch

data processing. To change the location of the folder, click the Browse button

corresponding to the folder, locate the directory and click Open. You cannot

leave the locations blank, as these are mandatory fields.

Settings Wizard
Database
Time View Time Clack
(@) Advanced & On
() Simple O off
Folders
= Wwiork Folder:
|C:"-.Prog|am Files"Easy Trinity".Easy Time Cortrol\Waork Folder | [ Browse... ]
= History Folder:
|C:"-.F‘roglam Files"Easy Trinity".Easy Time Control\History Folder | [ Browse ... ]
- Database Path:
|C:"-.Prog|am Files"Easy Trinity".Easy Time Control\Data".TrComm | [ Browse... ]
- Reguired fields

Descriptions
This Wizard will help you
manage your program
Settings.

"Advanced’ - working time
will be calculated
considering shifts settings.

"Simple' - working time will
be calculated without
considering shifts settings.

"fou can change a pathto |8
" your database and define |
* vour folders for automatic
unches processing.

B "Work Directory’ - a
directory for automatic
punches that were not
stored in your database.

"History Directory’ —a

Database

Click Next to continue. You have completed all the steps in the Setup Wizard. Click

Close Wizard.



Module 8
Working with Reports



Easy Time Control provides various reports. This module provides an insight into the

various reports available and explains the steps to generate the reports.

"_i: Reports

To access the reports, click the Reports tab from the left pane. If the

tab is not visible, click the Reports " icon.

6.1. General Procedure

To generate any report, select the Company from the Company Structure on the right
pane. To use the accounting period of the company, select the option Use Company
Accounting Period. If you do not want to use the company’s accounting period, you
can choose the dates from the calendar that is displayed. Click a date and drag
through the dates to include them in the report. Note that the dates included for the

report will be highlighted.

You can generate a report for the entire company, a particular department, or

particular employees.

Below the calendar two lists are displayed. The list on the left displays the
departments and employees of the selected company. To generate a report for the
entire company, click . The company, the departments, and the employees
will be added to the list in the right.

Now if you want to generate the report for a particular department or specific

employees, select the department or employee, and click to add them to
the list in the right.

o

To remove the items from the list in the right, click either[ ] or[

Click the Generate Report button to generate the report.



6.2. Report Options

The reports are generated in the Report Viewer. This viewer has the following options:

Options Description
P To navigate to the next page.
M To navigate to the last page in the report viewer.
4 To navigate to the first page in the report viewer.
4 To navigate to the previous page.

B To go to a particular page in the report viewer. In the dialog that

pops up enter the page number and click OK.

¥ To close the report viewer.
&£ To print the generated report.

To refresh the report.

To export the report to .pdf, .doc, .rtf, .xls. In the Export Report
& dialog browse to the location where you want to the save the report,

and click Save.

To display the group tree in the report viewer. This button acts as a
toggle. Click the button to hide the group tree.

To zoom the page. Click the dropdown and choose the zoom
@ - percentage. You can also customize the zoom. Click Customize
from the menu, enter a value between 25 and 400 and click OK.

To search for a particular text in the report. In the Search Text
dialog, enter the text and click OK. The text, if found, will be
highlighted. Click Find Next to go to the next occurrence of the

text.



6.3. The Time Card Report
You can access this Time Card Report from the left pane or from the Reports menu.

You can generate a Detailed Time Card or Summary Time Card.

Time Card Report

{ Settings

Use Company Accounting Period

4 December 2007 January 2003 February 2003 3
Mm T W T F 5 5 M T W T F 5 5 M T W T F 5 5
i 2 1 2 3 4 5 6 1 2 3
3 4 5 o 7 8 9 7 8 9 1 11 12 13 4 5 & 7 8 9 10
0 11 12 13 14 15 18 14 15 1 17 18 18 20 11 12 13 14 15 18 17
17 18 19 20 21 22 23 21 22 23 24 2% 28 27 18 19 20 22 23 24
24 25 26 27 28 29 30 28 29 30 3 25 26 27 B/ B
31
= o Es = o Es
=-@8 Development =@ Sales

£ Jean Wiliams £ Dominic Thompson
£ Jerold Moore £ Evan Scott
£ Maddison Robinson % Kegan Carer

£ Jem Jackson £ Handy Gonzales
ﬂ Rob Vright ﬁ, Lenmy Campbell

—Report Options

© Detailed Time Card Dedicate Separate Page for Each Employee

() Summary Time Card

(Generate Report

2/21/2008 12:43 PM NUM  SCRL

Report options for Time Card report



Detailed Time Card

If you choose to generate a detailed time card, you have the option to print the details
of each employee on separate pages. Choose the option Dedicate Separate Page for
Each Employee. After making the selections, generate the report. For each employee
this report displays the:

e TimeIN

Time OUT

e Total Hours

e Shift

e Exception Hours
e Break Hours

e Actual and Paid Hours

e QOvertime Hours

leport Viewer
Har M xSE&T= -
| MainFepor |
|
Time Card Report 25/2008 5:41:40PM
Accounting Period: 01/20/2008 - 01/26/2008
ABC
Sales
Dominic Thompson IN our Hours Shift
D: 1
Tuesday, January 22, 2008 6:50:00 am 3:20:00 pm 8:30:00 Day =
Wednesday, January 23, 2008 6:40:00 am 3:10:00 pm 8:30:00 Day
Thursday, January 24, 2008 6:30:00 am 3:20:00 pm 8:50:00 Day
Friday, January 25, 2008 7:00:00 am 3:00:00 pm 8:00:00 Day
Saturday, January 26, 2008 7:00:00 am 3:00:00 pm 8:00:00 Day
Break Hours: 345
Exceptions 0:00
Actual Hours: 41:50:00 L
Paid Hours: 38:05:00
Overtime Hours:  0:35:00
L]
Current Page No: 1 | Total Page No: 1+ | Zoom Factor: 100% |

Detailed Time Card report
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Summary Time Card
For each employee and the department this report displays the:
e Break Hours
e Exception Hours
e Actual and Paid Hours
e Overtime Hours

Note: When you generate the summary time card, the option Dedicate Separate

Page for Each Employee will be disabled.

ort Viewer

HAr M XS B &= a-d

Time card Repon 2/5/2008 6:58:17PM
ABC
Accounting Period: 01/ - 0
Sales
Dominic Thompson
Ereak Hours: 345
Exceptions 0:00
Actual Hours: 41:50:00
Paid Hours: 38:05:00
Overtime Hours:  0:35:00
Evan Scott
Break Hours: 215
Exceptions 0:00
Actual Hours: 24:50:00
Paid Hours: 22:35:00
Overtime Hours:  0:00
Handy Gonzales
Break Hours: 3:00
Exceptions 0:00
Actual Hours: 34:10:00
Paid Hours: 31:10:00
Overtime Hours:  0:00
Kegan Carter
Ereak Hours: 1:30
Exceptions 0:00
Current Page Mo: 1 | Total Page No: 1+ | Zoom Factor: 100%

Summary Time Card report
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6.4. Employees Assignment Report

This report displays the shift assignment for the employees.

Sales
Dominic Thompson
ID: 1
Day

Evan Scott
iD: 2

Night

Employees Assignment

Assignment From

01/21/2008
01/28/2008
02104/2008
02/11/2008
02/18/2008
02125/2008
03/03/2008
03/10/2008
03/17/2008
03/24/2008
03/31/2008
04/07/2008
04/14/2008
04/21/2008

Assignment From

01/21/2008
01/28/2008

ANINA ARG

ABC

Assignment To

01/27/2008
02/03/2008
0210/2008
02/17/2008
02/24/2008
03/02/2008
03/09/2008
03/16/2008
03/23/2008
03/30/2008
04/06/2008
04{13/2008
04/20/2008
04/27/2008

Assignment To

01/27/2008
02/03/2008

AnAMAND

Mon
Yes

Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

Yes

Mon
Yes

Yes

Tue
Yes

Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

Yes

Tue
Yes

Yes

2/5/2008 6:59:33PM

Wed Thu Fri Sat Sun
Yes Yes Yes Yes No

Yes Yes Yes Yes No
Yes Yes Yes Yes No
Yes Yes Yes Yes No
Yes Yes Yes Yes No
Yes Yes Yes Yes No
Yes Yes Yes Yes No
Yes Yes Yes Yes No

Yes Yes Yes Yes No
Yes Yes Yes Yes No
Yes Yes Yes Yes No
Yes Yes Yes Yes No
Yes Yes Yes Yes No
Yes Yes Yes No Mo

Wed Thu Fri Sat Sun
Yes Yes Yes No No

Yes Yes Yes No No

Mo Mee Wen Rle Ko

Current Page No: 1

| Total Page No: 1+

| Zoom Factor: 100% |

Employees Assignment report
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6.5. Exception Assignment Report

This report displays the exceptions assigned to the employees. The exception name,

the date, the hours are displayed.

HAr P XS E & &-M

Accounting Period: 1/20/2008
Sales

Dominic Thompson

ID: 1

Hours: 8.00
Evan Scott
ID: 2

Hours: 8.00
Handy Gonzales
ID: 3

Hours: 8.00
Kegan Carter
ID: 4

Hours: 8.00

Exception Assignment Report

21572008 7:04:22PM

ABC
- 1/26/2008

Exception =

Name Date Hours

Holiday 1/10/2008 &
Exception

Name Date Hours

Holiday 1/10/2008 ]
Exception

Name Date Hours

Holiday 1/10/2008 8
Exception

Name Date Hours

Holiday 1/10/2008 8

Current Page No: 1

| Total Page Mo: 1

| Zoom Factor: 100% |

Exception Assignment report
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6.6. Onsite Presence

This report displays the list of employees who have punched in during the time the

report is generated. This report works only for employees who are assigned to a

particular shift for that day and their punch IN times are within the shift timings.

HAr ME XS B i -

|
Onsite Presence Report e
ABC
Development First Name Last Name Punch's Date & Time
Jerri Jackson 2/18/2008 9.37:19PM
Employees Count: 1
Sales First Name Last Name Punch's Date & Time A
Dominic Thompsen 2/18/2008 9:27:37PM 3
Employees Count: 1
Total Employees Count: 2
L]
Current Page Mo: 1 | Total Page No: 1 | Zoom Factor; 100%

Onsite Presence report
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6.7. Late Comers Report

If the employees’ punches do not comply with the Punches Rounding Rules for punch

IN, the employee will be considered as being late. This report shows the list of

employees who have been coming late during the reporting period. The date and time

are displayed.

Report Viewer

HAdr P XS B i &-M

Lo}
Late Comers Re port 2/5/2008 7:06:05PM
ABC
Accounting Period: 01/ -0
Sales

Full Name Date and Time

Evan Scott 1/22/2008 11:05:00PM
L]

Current Page No: 1 | Total Page Ma: 1 | Zoom Factor: 100% |

Late Comers report
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6.8. Absence

This report displays the employees who were absent during the reporting period. The

report shows the dates on which the employees were absent.

HA)r P XS B i -

Absence Report 2/5/2008 7:14:03PM
ABC

Accounting Period: 01/ - 01
Sales

ID: 1 Dominic Thompson

Date of Absence
21-January-2008
28-January-2008
29-January-2008

Current Page No: 1 | Total Page No: 1 | Zoom Factor: 100% |

Absence report
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6.9. Saved Hours
This report shows the hours saved, in minutes, for each employee, the department,
and the company. Saved hours is the difference between the actual total working time

of the employees and the total time paid for, which is calculated after applying the

rounding rules.

HAr P XS E & -

Saved Hours Report 2/5/2008 7:16:50PM =
ABC
Accounting Period: 01/20/2008 - 01/29/2008
Sales
D Full Name Saved Hours (min)
5 Lenny Campbell -3 4
4 Kegan Carter 2
3 Handy Gonzales 2
2 Evan Scott 4
1 Dominic Thempson -9
Sales Total
Saved Hours: -4 5
ABC Total
Saved Hours: -4
|
Current Page No: 1 | Total Page No: 1 | Zoom Factor: 100% |

Saved Hours report
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